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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross 
Technology. 
Our mission is to:
1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach 
out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality 
customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to 
guide our behavior:
1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong 
and it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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EMC Notices
United States of America - FCC Part 15

This equipment has been tested and found to comply with the limits for a class A Digital device, 
pursuant to part 15 of the FCC Rules.

These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a Commercial environment. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this equipment in 
a residential area is likely to cause harmful interference in which case the user will be required to 
correct the interference at his own expense.

Canada

This Class A device complies with Canadian ICES-003 and part 15 of the FCC Rules.

Cet appariel numerique de la classe “A” est conforme a la norme NMB-003 du Canada.

European Union

This equipment is in compliance with the essential requirements and other relevant provisions 
established under regulation (EC) No 765/2008 and Decision No 768/2008/EC referred to as the 
“New Legislative Framework”.

Australia/New Zealand

This equipment is in compliance with the provisions established under the Radiocommunications 
Act 1992 and Radiocommunications Labelling (Electromagnetic Compatibility) Notice 2008.

Korea

This equipment is in compliance with the provisions established under the Radio Waves Act.

Class A equipment (Broadcasting and communications service for business use).

This device is a business-use (Class A) EMC-compliant device. The seller and user are advised to be 
aware of this fact. This device is intended for use in areas outside home.

International

This equipment has been tested under the requirements of CISPR 22:2008 or CISPR 32:2015 and 
found to comply with the limits for a Class A Digital device.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Ltd. could 
void the user’s authority to operate this equipment.

Warning — This equipment is compliant with Class A of CISPR 32. In a residential environment this 
equipment may cause radio interference.

Notice — This is a Class A product. In domestic environments, this product may cause radio 
interference, in which case the user may have to take adequate measures.
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Warranty and Repair Policy
The product is backed by a comprehensive one-year warranty on all components.

If an item becomes defective within the warranty period Ross will repair or replace the defective 
item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are 
conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of 
Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be 
supplied free of charge while defective items undergo repair. Return packing, shipping, and special 
handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or 
application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or 
consequential damages (including loss of profit). Implied warranties, including that of 
merchantability and fitness for a particular purpose, are expressly limited to the duration of this 
warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of 
ownership.

Extended Warranty

For customers that require a longer warranty period, Ross offers an extended warranty plan to 
extend the standard warranty period by one year increments. For more information, contact your 
regional sales manager.

Environmental Information
The equipment may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need 
for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back 
systems. These systems will reuse or recycle most of the materials from your end-of-life equipment 
in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your 
local or regional waste administration. You can also contact Ross Video for more information on the 
environmental performances of our products.

This appliance may contain a Coin type battery which should not be treated as household waste.

To ensure that the battery will be treated properly use the appropriate take-back systems in your 
area. These systems will reuse or recycle most of the materials from your end-of-life equipment in 
an environmentally friendly and health conscious manner.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Limited 
could void the user’s authority to operate this equipment.



Company Address

Ross Video Limited 
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613  652  4886

Fax: (+1) 613  652  4425

Technical Support: (+1) 613  652  4886

After Hours Emergency: (+1) 613  349  0006

E-mail (Technical Support): techsupport@rossvideo.com

E-mail (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Introduction
This guide covers the installation, configuration, and operation of the Ultritouch-2-HR and 
Ultritouch-4. The following chapters are included:

• “Introduction” summarizes the guide and provides important terms, and conventions.
• “Getting Started” provides an overview for creating a routing system with Ultritouch, and 

general information to keep in mind before installing and configuring your Ultritouch panel.
• “Hardware Overview” provides a basic introduction to the Ultritouch front and rear panels.
• “Physical Installation” provides instructions for the basic physical installation of the Ultritouch 

panel.
• “Cabling” provides instructions for connecting the Ultritouch to your network, and connecting the 

panel to a power source.
• “Configuring the Network Settings” provides instructions for configuring the network settings 

for the Ultritouch and navigating the touch-screen menus.
• “Basic Navigation” outlines the methods for accessing the Ultritouch menu system.
• “Communications with Devices” outlines how to enable the Ultritouch to communicate with 

devices in your routing system. 
• “File Management” outlines how to load a custom panel to Ultritouch and how to access the File 

Navigator interface, and manage your device files from the Ultritouch panel.
• “Managing Open Windows” outlines how to use this feature to quickly navigate, manage, and 

operate the devices connected to your Ultritouch.
• “Menu System Overview” summarizes the functions, menus, and parameters of the Ultritouch 

tabs and windows in DashBoard.
• “Technical Specifications” provides the specifications for the Ultritouch.
• “Glossary” provides a list of terms used throughout this guide.

Related Publications
It is recommended to consult the following Ross documentation before installing and configuring 
your Ultritouch:

• DashBoard User Manual, Ross Part Number: 8351DR-004
• Ultritouch Quick Start Guide, Ross Part Number: 2201DR-902
• Ultritouch + Ultrix User Guide, Ross Part Number: 2201DR-904
• Ultrix and Ultricore Database Guide, Ross Part Number: 2201DR-109
• ULTRIX-FR1, ULTRIX-FR2, and ULTRIX-FR5 User Guide, Ross Part Number: 2101DR-004
• ULTRIX-FR12 User Guide, Ross Part Number: 2101DR-604
• Walkabout Application Note, Ross Part Number: 2201DR-003

 The user documentation is available for download from our website.

Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user 
must enter, or a sequence of menus and sub-menus that must be followed to reach a particular 
command.
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Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For 
example:

In the Edit dialog, click Insert Above.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the Ultrix User Guide.

Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. 
For example, if a step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions
Star icons are used to identify important instructions or features. For example:

 Contact your IT department before connecting to your facility network to ensure that there are 
no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and 
Gateway for your device.

Contacting Technical Support
At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as 
the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. 
After-sales service and technical support is provided directly by Ross Video personnel. During 
business hours (Eastern Time), technical support personnel are available by telephone. After hours 
and on weekends, a direct emergency technical support phone line is available. If the technical 
support person who is on call does not answer this line immediately, a voice message can be left 
and the call will be returned shortly. This team of highly trained staff is available to react to any 
problem and to do whatever is necessary to ensure customer satisfaction.

• Technical Support: (+1) 844-652-0645
• After Hours Emergency: (+1) 613-349-0006
• E-mail: solutions@rossvideo.com 
• Website: http://www.rossvideo.com 

mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Getting Started
If you have questions pertaining to the operation of Ultritouch, contact us at the numbers listed in 
“Contacting Technical Support”. Our technical staff is always available for consultation, training, 
or service.

 This guides uses the term Ultritouch to reference both the Ultritouch-2-HR and Ultritouch-4 
unless otherwise noted.

Overview
Ultritouch is a forward thinking, powerful system control panel from Ross Video. The panel is a 
rack-mountable touchscreen that combines traditional functionality while adapting work flows in a 
simple and intuitive interface. Due to its integration of DashBoard, Ultritouch controls a host of 
other Ross equipment in addition to third-party signal processing products.

Ultritouch supports a full version of DashBoard, which allows users to control and monitor things 
like openGear cards, create custom panels, etc. Not only do these new enhanced panel work flows 
encompass the broad range of hard panel operations, but they also provide a fully integrated touch 
UI that enables a user to quickly setup and use their panel.

The touchscreen also means that users can use the common DashBoard framework to build a 
completely custom set of panels with different button combination sizes, functions, and layouts, 
enhancing what is possible from a normal hardware button-based panel. Ultritouch combines 
common DashBoard touch controls, enhanced work flow specific product controls, and the ability 
to make completely user-definable panels for any application.

Features
The Ultritouch is used when you require advanced control functions from a single point. DashBoard 
client software runs on the Ultritouch panel to provide flexible connectivity. 

The following features are included:

• Touch-enabled DashBoard based remote control panel (RCP)
• Redundant power supply option
• Integrated speakers for monitoring
• HDMI and USB for external KVM operation
• DashBoard client software built on Ethernet and TCP/IP technology to allow remote access across 

LAN architectures
• Standard UI layout for openGear cards
• DashBoard tree and system management support
• Ability to store multiple panel types with intuitive navigation based on desired work flow
• Load customized user interfaces to control a wide range of Ross Video products and third-party 

systems
• Full control of DashBoard Connect devices with real-time control and alarming from a single 

Ultritouch panel
• Ability to have multiple control views active and available for selection on one touchscreen
• Easily upgrade the software and firmware on the Ultritouch panel in the field
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System Overview
The Ultritouch is used when you require advanced control functions from a single point.

Figure 1  Example of a Possible Routing System with Ultritouch-2-HR

Before You Begin
Before configuring and operating the Ultritouch, contact your IT department before connecting to 
your facility network to ensure that there are no conflicts. 

Installation and Setup Overview
The generalized work flow of installing and configuring your Ultritouch is:

1. Implement your routing system plan by installing the devices, configuring their settings, and 
setting up your databases and matrices. Refer to the Ultrix and Ultricore Database Guide.

2. Install and configure the Ultritouch.

3. Establish communications between Ultritouch and the devices in your routing system.

4. Install required license keys for additional device control.

For More Information on...
• downloading and installing DashBoard, refer to the DashBoard User Manual.
• planning and installing your routing system, refer to the user documentation that accompanied 

your devices.

ULTRIX-NS-FR2
64x64 3G/HD/SD SDI Router

ENET 2

ENET 1

1 4 A B 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

AUX A AUX B

OUT IN
REF

Ultritouch-2-HR
Remote Control Panel

C DA B

Ultrix HDX-IO !
9 10 11 12 13 14 15 16

OUT
5 6 7 81 32 4 9 10 11 12 13 14 15 16

IN
5 6 7 8321 4

C DA B

Ultrix HDX-IO !
9 10 11 12 13 14 15 16

OUT
5 6 7 81 32 4 9 10 11 12 13 14 15 16

IN
5 6 7 8321 4

C DA B

Ultrix HDX-IO !
9 10 11 12 13 14 15 16

OUT
5 6 7 81 32 4 9 10 11 12 13 14 15 16

IN
5 6 7 8321 4

Network Switch

PORT 2 PORT 3 PORT 4 PORT 5 PORT 6 PORT 7 PORT 8PORT 1

PC running DashBoard

Internet / LAN / VPN

ULTRIX-NS-FR1
32x32 3G/HD/SD SDI Router

ENET 2

ENET 1

1 4 A B 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

AUX A AUX B

OUT IN
REF

T-BUS
PORT 2PORT 1

ETHERNET

COM1

COM2

PSU 1

PSU 2 ALARM

Ultricore
Central Controller

Ultritouch
Device

Device Name: Ultritouch_01

Device ID: ABCDEFG12345

Type: Ultritouch

Serial: 1234567890123
General Info

Manage Open Views

1
of
4

Upload

Reboot Device

C DA B

Ultrix HDX-IO !
9 10 11 12 13 14 15 16

OUT
5 6 7 81 32 4 9 10 11 12 13 14 15 16

IN
5 6 7 8321 4



Ultritouch User Guide (v3-rev2) Getting Started • 15

Ultritouch Operation Overview
Once configured, the Ultritouch provides central controller functionality for the routing system, 
including:

• the storage and implementation of routing system configurations, which collect a series of 
routing matrices into a system and provide a logical database view of the whole system

• switching the physical crosspoints of the routers according to the system configuration
• the control and system database interface for devices that control and/or display routing status 

(e.g. remote control panels, switchers, master control, automation systems, multi-viewers, and 
tally systems)

• virtual routing, matrix partitioning, and mapping
• label support for protocols supporting labels
• system control through DashBoard client software running on the Ultritouch panel
• connection and status logging 

For More Information on...
• databases, refer to the Ultrix and Ultricore Database Guide.

Using Custom Panels on Ultritouch
Once your router connections are defined, and a database is established, you can start building a 
map of several different physical devices that become one virtual device. When a switch request is 
made for a virtual device, all the physical devices that are mapped to the virtual device are switched. 

Ultritouch enables you to map inputs and outputs from routers for control via any remote control 
panel. These parameters can be saved to a database, enabling you to change configurations easily 
and quickly, allowing devices to used in a number of different operating scenarios.

For More Information on...
• databases, refer to the Ultrix and Ultricore Database Guide.
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Hardware Overview
This chapter presents information on the front and rear panels of the Ultritouch-2-HR and 
Ultritouch-4.

Front Panel Overview
Each Ultritouch front panel is a touchscreen display that enables you to access the features, 
settings, and monitoring options of the product. (Figure 2, Figure 3)

Figure 2  Ultritouch-2-HR — Front Panel with Ultritouch Device Interface Displayed

Figure 3  Ultritouch-4 — Front Panel with Ultritouch Device Interface Displayed

1. DB Button

Tap this button to display the Ultritouch Device interface, which is the main/Home menu. From 
this interface you access the following configuration features:

› General Info
› Manage Open Views
› Manage Custom Panels
› Connected Devices
› Network Settings
› License Management

Ultritouch
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1
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2. Connected Devices Button

Tap this button to display the All Connections interface in the Main Window. This interface 
reports the external devices that are communicating with the Ultritouch. Each device is 
represented as an individual button that when tapped displays the DashBoard menu system in 
the Main Window. Devices are added to the All Connections interface via the Ultritouch Device > 
Connected Devices interface.

3. File Navigator Button

Tap this button to display the File Navigator interface in the Main Window. Use this interface to 
select any custom panels uploaded into Ultritouch. 

4. Open Windows Button

Tap this button to reveal thumbnails of the currently open windows. Tapping a thumbnail opens 
that window full screen. This is useful for swapping between control panels for different devices.

5. Lock Button

Tap this button to lock the Ultritouch panel and display a spinner icon. You must tap and spin the 
icon to unlock the interface.

6. Home Window

The items in this window change depending on the function selected. This window can also 
display the currently loaded Ultrix soft panel or a custom panel for a DashBoard Connect 
compatible device.

7. Headphone Jack (Ultritouch-4RU only)

This is a 3.5mm headphone jack. When in use, the internal speaker of the Ultritouch panel is 
muted.

8. USB Port (Ultritouch-4RU only)

This is a standard USB 3.0 port. This port is not implemented.

Rear Panel Overview
The Ultritouch rear panel provides connections for power supplies, communications, and network 
connections. 

For More Information on...
• the power specifications, refer to Table 9.
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Figure 4  Ultritouch-2-HR — Rear Panel, Side View

Figure 5  Ultritouch-4 — Rear Panel, Side View

1. PWR1 and PWR2 Connections

There are two power supply connectors located on the rear of each Ultritouch. Each connector 
requires a 15VDC connection to an external power supply. 

Each Ultritouch ships with one power supply. An option is available to order a second power 
supply for redundancy.

Notice — The Ultritouch automatically powers on when power is applied.
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2. HDMI Port

This port is not implemented.

3. USB Port

This port is not implemented.

4. ENET1 and ENET2 Ports

Each ENET port is an RJ45 connector used to connect the Ultritouch to an external Ethernet 
network. 

Use the to bridge the external Ethernet network to the local communications bus for monitoring 
and control of the Ultritouch. 

 The ENET 2 port is not implemented.

Notice — The Ethernet ports do not provide, nor make use of, Power-over-Ethernet (PoE).
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Physical Installation
If you have questions pertaining to the installation of Ultritouch, contact us at the numbers listed in 
“Contacting Technical Support”. Our technical staff is always available for consultation, training, 
or service.

Before You Begin
These installation guidelines assume the following:

• The relevant Ross equipment is installed into a ventilated rack frame. The relative humidity in the 
environment of the equipment should be <70% (non-condensing). The ambient temperature of 
the air entering the front panel should not exceed 40°C (104°F), and should not fall below 0°C 
(32°F).

• The install location of the panel should be accessible, dry, and dust-free.
• The socket/outlet should be installed near the equipment and be easily accessible.
• Valid IP addresses are assigned to the equipment by your IT Department.

Static Discharge

Throughout this chapter, please heed the following cautionary note: 

Mounting Requirements
Under some conditions, the ambient air temperature inside rack-mount cabinets can be greater 
than the ambient temperatures within a room. For safe long term reliability, ensure the ambient air 
temperatures of the panel are within the panel’s specified operating temperature range. Adequate 
ventilation within a rack frame must also be maintained.

For More Information on...
• the technical specifications for the Ultritouch, refer to “Technical Specifications”.

Rack Mounting the Ultritouch
The Ultritouch panel is designed for installation into a standard 19” equipment rack. It has 
integrated rack ears, allowing it to be screwed in using standard screws and cage nuts.

The Ultritouch panel mounts in the rack frame by means of four rack screws fastened through the 
front mounting ears. This should normally be sufficient to carry the load, including the weight of 
accompanying cables. 

For More Information on...
• rack mounting the Ultritouch, refer to the Ultritouch Quick Start Guide.

VESA Mounting the Ultritouch-4
The Ultritouch-4 can also be used in a VESA 100mm compliant (flat-back) mount where there are 
four holes at 100mm pitch in a square pattern on the center of a VESA mounting application. 
Installing the Ultritouch-4 to a VESA mount requires you to:

ESD Susceptibility — Static discharge can cause serious damage to sensitive semiconductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.
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1. Remove the rack mount brackets from either side of the Ultritouch-4 panel. 

2. Install the U4-VESA100 plate to the Ultritouch-4 panel. 

3. Install the Ultritouch-4 and U4-VESA100 plate to your VESA mount.

Required Equipment
You will need:

• One Phillips #1 screwdriver
• One Phillips #2 screwdriver
• One Ultritouch-4 panel
• One U4-VESA100 Kit which includes one plate (P/N 2201FR-089), four #6-32 screws (P/N 

88-01087), and four M4 mounting screws (P/N 850-062R)

Removing the Rack Mount Brackets from the Ultritouch-4
The Ultritouch-4 comes standard with rack mount brackets affixed to each side of the panel via six 
screws per bracket. Each rack mount bracket includes a front mounting ear and an end bracket. 
When installing the Ultritouch-4 in a VESA mount application, you must first remove each rack 
mount bracket from the Ultritouch-4 panel, separate the front mounting ear from the end bracket, 
and then re-install the end bracket back onto the panel. 

To remove the rack mount brackets from the Ultritouch-4 panel

1. Set the Ultritouch-4 on a flat, clean, and static-free surface with the display facing away from 
you. 

2. On the left-side of the Ultritouch-4, locate the six screws that affix the rack mount bracket to the 
panel.

3. Use a Phillips #1 screwdriver to remove the screws. Set the screws aside.

 You will need these screws to re-install the end bracket onto the Ultritouch-4 panel.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semiconductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.
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Figure 6  Removing the Left Rack Mount Bracket from the Ultritouch-4 Panel

4. Pull the rack mount bracket away from the Ultritouch-4.

5. Separate the front mounting ear from the end bracket. Set the front mounting ear aside.

6. Re-install the end bracket onto the left-side of the panel using the screws from step 3.

Figure 7  Re-installing the Left End Bracket on the Ultritouch-4 Panel

7. Repeat steps 2 to 6 for the rack mount bracket on the right-side of the panel.

Installing the U4-VESA100 to the Ultritouch-4
The U4-VESA100 plate includes four pairs of opposing holes and four #6-32 screws. You must 
position the plate over the four VESA Adapter Plate holes on the Ultritouch-4 panel, then attach the 
plate using the provided screws.

To install the U4-VESA100 to the Ultritouch-4

1. Determine where and how the Ultritouch-4 will be affixed to the VESA mount. Ensure:

• the Ultritouch-4 will not interfere or block any ports, connectors, or other features of nearby 
equipment;

End Bracket

Front
Mounting Ear
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• access to the Ultritouch-4 connections is available once it is installed on the VESA mount.

2. Set the Ultritouch-4 on a flat, clean, and static-free surface with the display facing down. 

3. Locate the four VESA Adapter Plate holes (outlined with white circles) on the rear of the 
Ultritouch-4 panel.

4. Position the U4-VESA100 plate over the four holes.

5. Use a Phillips #2 screwdriver and the provided screws to fasten the plate to the panel. (Figure 8)

Figure 8  U4-VESA100 Bracket on the Ultritouch-4 Panel

Installing the Ultritouch-4 to a VESA Mount
The U4-VESA100 is designed to be used in a VESA 100mm compliant (flat-back) mount where there 
are four holes at 100mm pitch in a square pattern. You will need to use these four holes to affix the 
Ultritouch-4, via its U4-VESA100 plate and the provided four M4 mounting screws, to the VESA 
mount.

 The four M4 mounting screws assume your VESA mount has a material thickness of ~2mm 
(0.08”).

To install the Ultritouch-4 to a VESA 100mm mount

1. Install the VESA 100mm mount as outlined in its documentation.

2. Position the Ultritouch-4 over the VESA mount, ensuring the U4-VESA100 plate aligns over the 
screw holes of your VESA 100mm mount.

3. Secure the Ultritouch-4 to the VESA mount using the provided four M4 mounting screws.

 Ensure your mounting screws accommodate the Ultritouch-4 U4-VESA100 plate yet still engage 
with the mount. 

4. Secure the Ultritouch-4 power supply.

U4-VESA100 Plate
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Cabling
This chapter outlines how to establish a physical connection between the Ultritouch panel and your 
facility network, and then to a power supply.

Connecting the Ultritouch to a Network
The ENET 1 port is a standard 10/100/1000 RJ45 Ethernet connector and is used to exchange data 
and communicate with other devices in your router system. 

 Contact your IT department before connecting to your facility network to ensure that there are 
no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and 
Gateway for your device.

The Ultritouch is connected directly to your network so that it can interface with the devices in your 
routing system. After a physical connection is established, use the DashBoard client running on 
your Ultritouch to configure the network settings for the Ultritouch.

 Contact your network administrator if difficulties or problems are experienced when connecting 
the Ultritouch to a network hub, or with assigning IP addresses.

To establish a physical connection to the network

1. Connect one free end of the straight through CAT5/5e/6 cable to a free port of the network hub.

2. Connect the other end of the same cable to ENET 1 on the Ultritouch rear panel.

Figure 9  Ultritouch-2-HR — ENET 1 Connection

To network hub
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Figure 10  Ultritouch-4 — ENET 1 Connection

Connecting to a Power Supply
The Ultritouch panel is powered by one +15V DC, 30W PSU, with an optional PSU available to 
provide redundancy and load sharing.

For redundancy, each power cord should be connected to a separate power source for protection 
against failure of the A/C power circuit. In the event of one power supply failure, the panel load is 
seamlessly transferred to the other connected redundant power supply.   

Warning Hazardous Voltages — The safe operation of this product requires that a protective 
earth connection be provided. This protective earth is provided by the ground conductor in the 
equipment’s supply cord. To reduce the risk of electrical shock to operator and service personnel, this 
ground connector must be connected to an earthed ground.

Warning — In some countries it may be necessary to supply the correct mains supply cord. Use only 
certified cords for the country of use.

To network hub
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To connect the power cables to the Ultritouch panel

1. Connect the male end of the provided power cable into the socket marked PWR1 on the 
Ultritouch rear panel.

Figure 11  Ultritouch-2-HR — Primary Power Connection 

Figure 12  Ultritouch-4 — Primary Power Connection 

2. Connect the remaining power cable into the PWR2 power supply socket if redundancy is 
required.

3. Connect the supplied AC power cable into the power modules.

4. Connect the supplied power cable’s three-prong male connector to an AC outlet.

Notice — The Ultritouch automatically powers on when power is applied.

Note: It is recommended that you 
always connect the Power Supply 
Unit to the Ultritouch-2-HR before 
connecting to Mains Power.

Note: It is recommended 
that you always connect 
the Power Supply Unit to 
the Ultritouch-4 before 
connecting to Mains 
Power.
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Configuring the Network 
Settings
The Ultritouch system comes pre-configured with default settings that you may wish to configure as 
per your facility requirements. This chapter outlines how to assign a static IP Address to the 
Ultritouch panel, and navigate the menu system of the touch-screen panel.

Overview
Updating the network settings is the first task to accomplish once the physical installation is 
completed. There are two methods outlined in this chapter:

• Walkabout — use the Walkabout application, running on a DashBoard client computer in your 
network.

• Ultritouch — use the touchscreen of the Ultritouch hard panel.

Using Walkabout to Assign the Ultritouch IP Address
Once the Ultritouch panel is physically installed and cabled to your facility network, you will need to 
assign it a static IP Address to enable DashBoard (running on a computer connected to the same 
subnet) to locate it on your network. Establishing a static IP Address enables the DashBoard client 
running on Ultritouch to detect other DashBoard Connect compatible devices on the same subnet.

To assign a static IP address to the Ultritouch panel
1. Launch a DashBoard client from a computer connected to the same IP address subnet as the 

Ultritouch.

2. From the DashBoard client main toolbar, select File > Show Walkabout.

The DashBoard window displays the Walkabout table.

3. Click Refresh, located at the bottom of the Walkabout tab, to ensure the list in the Walkabout 
table is current.

4. In the Walkabout table, find the entry for the Ultritouch you want to configure.

 It may be identified in the table via the default IP Address of 192.168.20.160.

5. Use the Name field to assign a unique identifier to the Ultritouch panel. This will be the name 
displayed in the Tree View of DashBoard.

 After you edit a cell in the Walkabout table, the Connection/Link Quality value for the device 
reports 1%. It is recommended to wait approximately 1 minute, then click Refresh to apply the 
new settings.

6. Use the Address field to specify the IP Address supplied by your IT Department for this device.

7. Ensure the Netmask field is set to match your network requirements.

8. Use the Gateway field to specify the IP Address for connection outside of the local area 
network (LAN).

9. Click Reboot in the row of the Walkabout table for the Ultritouch.
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Adding the Ultritouch to the Tree View in DashBoard
Once you have assigned the Ultritouch a static IP Address, you can then manually add it to the Tree 
View. Manually Adding the Ultritouch displays its node in the Tree View in the DashBoard client 
software on your computer, granting you access to the interfaces described in “Menu System 
Overview”.

To manually add the Ultritouch to the Tree View in DashBoard
1. In the Basic Tree View toolbar of DashBoard, click .

The Select Equipment or Service Type to Add dialog opens.

2. Expand the openGear/DashBoard Connect node.

3. Select TCP/IP DashBoard Connect or openGear Device.

4. Click Next >.

The TCP/IP DashBoard Connect/openGear Device dialog opens.

5. Select the JSON radio button as the Protocol.

6. Enter the IP Address for the panel in the IP Address field that you assigned in the section “To 
assign a static IP address to the Ultritouch panel”.

7. In the text fields provided, enter the display name and the port of the panel you wish to add.

8. Click Finish. 

The Ultritouch displays in the Tree View. 
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Updating the Network Settings for the Ultritouch via the Hard 
Panel
You may wish to change the Ultritouch network settings from the default values yet do not have 
access to a computer running the Walkabout application. The touch-screen menu system enables 
you to change the IP Address and update other network settings. There are two methods to assign 
an IP address to the Ultritouch: manually assigning the settings or enabling the DHCP server in your 
network to assign the settings to the panel. Both methods are described below.

To manually assign the network settings to the Ultritouch

1. Tap .

 You will need to scroll through the menu list displayed under the Ross logo.

2. Tap Network Settings.

3. In the DHCP area, tap Off.

4. Use the IP field to assign a static IP Address to the Ultritouch.

5. Use the Subnet field to specify the subnet mask for your network.

6. Use the Gateway field to specify the gateway for communications outside of the local area 
network (LAN) that the Ultritouch will use.

7. Tap Apply.

To automatically obtain the network settings for the Ultritouch

1. Tap .

 You will need to scroll through the menu list displayed under the Ross logo.

2. Tap Network Settings.

3. In the DHCP area, tap On.

4. Tap Apply.

Re-naming the Ultritouch
Each Ultritouch can be given a unique name that is used on internal menus and as the identifier in 
the routing system. 

To re-name the Ultritouch

1. Tap .

2. Tap General Info.

3. Select the Device Name field.

4. Type a new name for the Ultritouch in the Device Name field.

5. Tap Apply.
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Basic Navigation
There are two methods for accessing the Ultritouch menu system: via a DashBoard client running 
on a computer connected to the same subnet as the Ultritouch, or via the touchscreen of the hard 
panel. This chapter outlines both methods.

 This chapter uses the Ultritouch-2-HR in its examples, but the information also applies to the 
Ultritouch-4.

For More Information on...
• the menus and options in each interface, refer to “Menu System Overview”.

Using the Touchscreen
The Ultritouch touchscreen menu system is organized into four interfaces: Ultritouch Device, All 
Connections, File Navigator, and Open Windows. Each interface is represented as a button on the 
left toolbar of the panel. Tap a button to display that interface on the touchscreen. Figure 13 
illustrates the user selecting the Network Settings button on the Ultritouch Device interface.

Figure 13  Example of Navigating the Ultritouch Touchscreen

Use this method of navigating the menu system to access:

• multiple device views
• custom panels
• Ultrix soft panels

Navigating the Ultritouch Menus via the Touchscreen
The interfaces are accessed by tapping buttons on the main toolbar of the Ultritouch panel. 

To access the Ultritouch Device interface via the touchscreen

1. Tap .

2. To access additional menus:

Ultritouch
IP:

Mask:

Gateway:

DNS (Primary):

DNS (Secondary):

12.32.123.235

555.555.555.5

12.65.123.2

10.1.0.03

10.2.0.05

Connected Devices

Network Settings

Device Options

ON

DHCP

OFF

CANCEL APPLY



34 • Basic Navigation Ultritouch User Guide (v3-rev2)

a. Scroll through the menus using the arrows.

b. Tap a button to displays its interface.

 Note that the button you tap now displays a blue bar on its right side. 

To access the All Connections interface

• Tap .

To access the File Navigator interface

• Tap .

To access the Open Windows interface

• Tap .

 A maximum of 4 windows can be opened at one time. When the limit is reached, the panel with 
the earliest timestamp is automatically closed.

Using a DashBoard Client Computer

The Ultritouch displays as a device node in the Basic Tree View in the window of your DashBoard 
client. Much like other DashBoard Connect devices, you access the interfaces and menus of 
Ultritouch by first selecting its node in the Basic Tree View to display the device view of the panel in 
the DashBoard window.

When using a DashBoard client computer to access the Ultritouch, the interfaces are organized into 
a series of buttons at the bottom of the window. By default, the General Info interface displays as 
the homepage.

Use this method of navigating the menu system to:

• load device views
• load custom panels

Figure 14 illustrates an Ultritouch displayed in the DashBoard client window after the user selected 
the Network Settings button.
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Figure 14  Example of Navigating the Ultritouch Menus via the DashBoard Tree View

Navigating the Ultritouch Menus via a DashBoard Client Computer
 The DashBoard client computer must be connected to the same subnet as your Ultritouch panel.

To access the Ultritouch Device interface via a DashBoard client computer
1. Launch DashBoard by double-clicking its icon on your computer desktop.

2. Ensure the DashBoard client computer is running DashBoard software version 8.5.0 or higher.

 This information is available by selecting Help > About DashBoard from the main toolbar.

3. Locate the Ultritouch in the Tree View of DashBoard.

4. Expand the Ultritouch node to display the Ultritouch Device sub-node.

5. Double-click the Ultritouch Device sub-node.

The Ultritouch Device interface displays in the right-side of the DashBoard window with a 
bottom toolbar that includes selectable buttons.
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Using with Ultrix
This chapter covers the installation, configuration, and use of the Ultritouch with your Ultrix router.

For More Information on...
• databases, refer to the Ultrix and Ultricore Database Guide.

Before You Begin
Keep the following in mind when managing your Ultrix soft panels for Ultritouch:

• Soft panels require the setup of the database source/destinations/levels and port assignment to 
be complete on the Ultrix router that will communicate with Ultritouch.

• If the Ultrix database changes (source/destination/level/salvo addition or deletion), you will need 
to:
› update the Ultritouch soft panel configuration in the Ultrix database to ensure the correct 

elements are visible;
› re-load the soft panel to the Ultritouch.

• Soft panels do not support Unicode characters.

Configuration Workflow
Refer to Figure 15 for an overview of the steps required before establishing communication 
between the Ultritouch and an Ultrix router.

Figure 15  Example Workflow for Setting Up an Ultrix Before Connecting to an Ultritouch

Refer to Figure 16 for an overview of the steps required to enable your Ultritouch to communicate 
with an Ultrix router.

Figure 16  Example Workflow for Setting Up an Ultritouch to Communicate with an Ultrix

Configure the Ultrix Database
A database defines the matrices, levels, sources, destinations, and soft panel for a particular router 
setup. A router may use a number of database configurations depending on its role in the routing 
system. 

For More Information on...
• creating and managing databases for an Ultrix router, refer to the Ultrix and Ultricore Database 

Guide.

Create a
Database on

Ultrix/Ultricore

Install the
Ultrix/Ultricore

Configure the
Ultrix/Ultricore

Create Ultritouch PB
Soft Panel(s)

on Ultrix/Ultricore

Install the
Ultritouch

Configure
the Ultritouch

Load a
Soft Panel

to Ultritouch

Enable Ultritouch
to Communicate

with Ultrix

Use the Soft
Panel on the

Ultritouch

Install the
License Key on

Ultritouch
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Create the Ultritouch Soft Panel in the Ultrix Database
A soft panel provides Ultritouch access to the sources, destinations, levels, and/or salvos that are 
available on the associated Ultrix router. The soft panel configurations are part of the Ultrix 
database so any instance of DashBoard or Ultritouch connecting to a given router has the defined 
soft panels available.

A soft panel is also a software implementation of a physical remote control panel (RCP). You can 
customize an Ultritouch soft panel by defining the sources, destination, levels, and/or salvos that 
will be available for use on the panel interface. A soft panel designed for Ultritouch also enables you 
to customize the look of the interface when it is loaded to the Ultritouch panel.

 An Ultritouch soft panel is created using the options in the Ultrix menu system.

For More Information on...
• databases, refer to the Ultrix and Ultricore Database Guide.

Install the ULTRITOUCH-RTR License Key
Ross Video uses license keys to control user access to specific Ultritouch features. In the case of an 
Ultrix router, you must install the ULTRITOUCH-RTR license key on the Ultritouch before it can 
communicate with a router.

To install an ULTRITOUCH-RTR license for your Ultritouch

1. Tap .

2. Tap License Management.

 This may also be accessed via a DashBoard client computer and navigating to the Ultritouch 
Device > Manage Licenses interface.

3. Locate the row for the ULTRITOUCH-RTR license.

4. Make a note of the character string in the Request Code field.

5. Contact your Ross representative.

a. When you speak to your Ross representative, tell them your name, facility name, and the 
Request Code from 4.

b. You will be given a License Key that must be entered in the License Key field for 
ULTRITOUCH-RTR.

6. Enter the provided License Key in the License Key field for ULTRITOUCH-RTR.

7. Tap Install Key.

Set up Communications between the Ultritouch and the Ultrix
Communication between Ultritouch and the Ultrix router is over ethernet via an established 
connection point. A connection point defines the interface and the protocol to be used for 
communication. 

Ultritouch uses the open SLP protocol to locate devices on the same network as it is connected to. 
There are two methods to setting up communications between the Ultritouch and Ultrix/Ultricore: 
using the auto-connect feature or manually adding the router by specifying its IP address.

To set up a connection point between Ultritouch and Ultrix/Ultricore

1. Tap .

2. Tap Connected Devices.

 This may also be accessed via a DashBoard client computer and navigating to the Ultritouch 
Device > Device Options interface.
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3. Tap Add.

4. Tap Manually Add a Connection Point.

5. Use the Device IP/Hostname field to specify the IP Address for the Ultrix router.

6. Tap Add Device.

The router is now listed in the Connected Devices table.

7. Select the router from the Connected Devices table.

8. Tap Connect.

Creating an Ultritouch Soft Panel
Creating a new soft panel, or editing an existing soft panel, requires you to work within the Ultrix 
database menu system. Before proceeding:

• create and load the required database to the Ultrix router;
• be familiar with using the Soft Panel Editor in the Ultrix menu system.
• ensure the soft panel you are editing is not currently loaded on an Ultritouch.

For More Information on...
• databases, refer to the Ultrix and Ultricore Database Guide.

Loading an Ultritouch Soft Panel to Ultritouch
The main toolbar on the Ultritouch provides a method for navigating to the soft panels available in 
your routing system. Loading a soft panel to an Ultritouch is similar to loading a soft panel to an 
Ultrix router or Ultricore Central Controller: from the main toolbar you locate the soft panel in the 
Panel tree of the database (panels are listed in a hierarchy as determined by Panel ID), and open it.

 Do not load a soft panel that is not designed specifically for an Ultritouch. A soft panel, other than 
one designed using the Ultritouch PB template, may not display correctly on the Ultritouch 
screen.

Using an Ultritouch Soft Panel
The layout of an Ultritouch soft panel automatically organizes the destinations, sources, and levels 
into distinct columns of buttons. Refer to “Elements of an Ultritouch Soft Panel” for more 
information.
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Soft Panels
A soft panel can be as simple or complex in its layout as you require. 

 Refer to the Ultrix and Ultricore Database Guide for more information on creating soft panels in 
your database.

Elements of an Ultritouch Soft Panel
To control an Ultrix router via Ultritouch, load a saved soft panel using the Ultritouch > All 
Connections interface. Loading a soft panel to Ultritouch requires a similar method as loading a soft 
panel in the Ultrix and/or Ultricore menu system. You select the device in the Ultritouch > All 
Connections interface, navigate to the specific soft panel you wish to load, and select it from the 
provided list. Soft panels are listed in a hierarchy as determined by their Panel ID.

 The layout of the soft panel depends on how it was configured in the Ultrix Panel Editor. The 
order of the windows in the soft panel is determined using the options in the Home View tab. 
Refer to “Defining the Home Page of the Soft Panel” for details.

Figure 17  Example of an Ultrix Soft Panel Loaded to an Ultritouch

1. Main Toolbar

This toolbar is fixed to the left side of the soft panel as part of the Ultritouch window and 
provides navigation buttons to access custom panels, connected devices, and file management. 

2. Home Page

This area is the Home Page of the soft panel and displays the windows defined during the soft 
panel configuration. By default, the Ultritouch PB soft panel template includes two drawers (3), a 
Destination window (4), a Sources window (5), and an Operations window (7). Figure 17 shows a 
customized soft panel that also includes a Status window (6) and an Output Monitor window (8). 
Each of these elements are summarized below.

3. Drawers

A navigation drawer is available on the left and right sides of the interface. Tap the drawer icon 
once to open a pane that provides access to additional menus and functions of your soft panel. 
Tap the drawer icon again to close the pane. The contents of a drawer is determined when the 
soft panel was configured.

4. Destination Window

Each button in this area represents a configured output for the selected router. Tap a button to 
include the destination in the next crosspoint switch. For example, Dest1 is selected in Figure 17. 
Note that the number of destinations and the button labels are defined in the Ultrix > Database > 
Destinations interface. The icon used on the button type (e.g. the headphone icon is used in 
Figure 17) is specified during the soft panel configuration.
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5. Sources Window

Each button in this area represents an input in the routing system. Tap a button to include the 
source in the next crosspoint switch. For example, Src12 is selected in Figure 17. Note that the 
number of sources and the button labels are defined in the Ultrix > Database > Sources interface. 
The icon used on the button type (e.g. the camera icon is used in Figure 17) is specified during 
the soft panel design.

6. Status Window

Tap a level button to include that level in the next crosspoint switch. Note that the number of 
levels and the button labels are defined in the Ultrix > Database > Levels interface. This window 
also displays the status of crosspoint selections. In Figure 17, Dest2 is selected for the next 
crosspoint switch.

7. Operations Window

This window of the soft panel groups operational features as defined when creating the soft 
panel. The following buttons can be located in this window:

› LOCK — This button displays when the Protection Operation was set to Enable during the 
soft panel design. Tap this button to prevent switching of the selected destination by any 
control device.

› PROTECT — Tap this button to prevent switching of the selected destination except by the 
panel that initiated the protect. If you are using a soft panel with the Protection Operation set 
to Disable, the PROTECT button is not displayed.

› FOLLOW — Tap this button to automatically select all the Level buttons listed on the soft panel 
(buttons are now lit). All levels are included in the next crosspoint selection.

› VIEW — Tap this button to display a list of presets that will be included in the next crosspoint 
switch.

› CLEAR — Tap this button to clear the selections made for the next crosspoint switch on the 
soft panel.

› PRESET — Tap this button to create a temporary list of multiple crosspoint switches that will be 
executed on the next transition.

› TAKE — Tap this button to execute the switch between the selected crosspoints. The soft panel 
does not display this button if the Take Operation was set to Direct during the soft panel 
design. Transitions will occur automatically after a crosspoint switch is selected.

This window also includes a read-only status field, located at the top of the window, that reports 
the currently selected destination.

8. Output Monitor Window

This area provides a thumbnail preview window of the next crosspoint switch. Refer to “Using 
the Output Monitor Window” for more information.

Accessing the Operations Features
The Operations window can be a fixed window on the soft panel, or assigned to a specific Drawer. 
Figure 18 shows a soft panel with an Operations window. The buttons available in the Operations 
window depend on the options enabled when the soft panel was configured. Refer to “Operations 
Window” for details.

Figure 18  Example of a Soft Panel with the Operations Window on the Right
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Filtering the Destination and Source Buttons
You can search the entries in the Destination and Source windows using the options in the Filters 
window. This is helpful when your database includes a large number of inputs and outputs and you 
wish only to access specific ones. Use the provided search fields to filter the entires in each window. 
(Figure 19)

Figure 19  Example of a Soft Panel with the Filters Window on the Right

Creating an Ultritouch Soft Panel
The Ultrix Soft Panels Editor enables you to specify the number of destinations, sources, levels, and 
salvos displayed on your panel. You specify the elements of the soft panel, such as what windows 
and additional menus to display and their order on the soft panel, and give the panel a unique 
name to make it easier to identify in your system. This section outlines how to create a soft panel 
(Ultritouch PB) specifically designed for use on an Ultritouch using the Ultrix Soft Panels Editor in 
DashBoard. 

Much like other types of soft panels, when you create a new Ultritouch PB soft panel, you select 
from an existing soft panel type (templates). You then assign a Panel Name and ID to display in the 
tree view using the nomenclature “Panel Name [#]” where [#] is the Panel ID.

Creating a new soft panel, or editing an existing soft panel, requires you to work within the Ultrix 
database menu system. Before proceeding:

• create and load the required database to the Ultrix router.
• be familiar with using the Soft Panel Editor in the Ultrix menu system.
• ensure the soft panel you are editing is not currently loaded on an Ultritouch.

To create a new soft panel for Ultritouch

1. Locate the Ultrix in the Tree View of DashBoard.

2. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

3. Expand the Database node.

4. Double-click the Panels node.

The Panels tab opens.

5. Click Edit... > Add.

The Add Panel dialog opens.

6. Type a unique identifier in the Name field. This will be used to identify the panel in the tree 
under the Soft Panels node.

7. Use the Style menu to specify Ultritouch PB. 

8. Click Apply to save your settings and close the Add Panel dialog.

The new panel name is added to the Saved Panels list of the Panels tab and is automatically 
selected for editing.
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To edit the soft panel operational features

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Click Info.

3. Use the Description field to provide a textual summary of the panel. 

4. Use the Protection Operation menu to provides options for preventing crosspoint switches. 
Choose from the following:

• Enable — The LOCK, PROTECT, and FREE buttons display on the soft panel. This is the default 
setting for Ultritouch soft panels.

• Disable — The LOCK, PROTECT, and FREE buttons do not display on the soft panel. These 
protection options are not available for the soft panel.

5. Use the Take Operation menu to configure the TAKE button for the soft panel. Choose from 
the following:

• Confirm — Displays a TAKE button on the soft panel. You must select the TAKE button to 
perform a crosspoint switch.

• Direct — The soft panel does not display a TAKE button. A crosspoint switch occurs 
automatically after each destination/source selection is made by the user on the soft panel. 
This is the default setting for Ultritouch soft panels.

6. Use the Machine Control menu to control whether a TAKE request directed to an Ross NK-M 
series router automatically makes a reciprocal port switch. Choose from the following:

• Enable — Displays a Machine Control button on the soft panel. You must select the Machine 
Control button to enable the reciprocal port switch on the NK-M series router.

• Disable — The soft panel does not display a Machine Control button. This is the default 
setting for Ultritouch soft panels.

7. Click Apply to save your new soft panel.

Specifying the Levels for the Soft Panel
You can specify the total number of levels available on the soft panel to the user. For example, if 
you set the Viewable levels to 6 but have assigned 8 levels to the panel, only the first six levels in the 
Assigned list are displayed. You can also specify the order in which the levels are displayed on the 
soft panel.

To specify the levels for the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Click Levels.

3. Use the Viewable levels field to specify the total number of levels for the soft panel.

4. To add a level to the soft panel:

a. From the Available list, select the level(s) you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected level(s).

5. To assign all the available levels in the database to the soft panel, click .

6. To assign multiple levels to the soft panel:

a. From the Available list, select the first level you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other level(s) you wish to add to the soft panel.
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d. Click .

The Assigned list updates to include the selected levels.

7. Use the provided buttons beside the Assigned list to determine the order in which the levels 
are displayed on the soft panel.

8. Click Apply at the bottom of the Panels tab to save your settings.

Specifying the Destinations for the Soft Panel
You can create a soft panel with a specified number of destinations and determine the order in 
which they are displayed in the Destinations window of the panel. For example, the router may 
have 32 destinations but you only want to make the first 4 outputs selectable on the soft panel. You 
would then move only the required destinations from the Available list to the Assigned list.

To specify the destinations for the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Click Destinations.

3. To add a destination to the soft panel:

a. From the Available list, select the destination(s) you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected destination(s).

4. To assign all the available destinations in the database to the soft panel, click .

5. To assign multiple destinations to the soft panel:

a. From the Available list, select the first destination you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other destination(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected destinations.

6. Use the provided buttons beside the Assigned list to determine the order in which the 
destinations are displayed on the soft panel.

7. Click Apply at the bottom of the Panels tab to save your settings.

Specifying the Sources for the Soft Panel
You can create a soft panel with a specified number of sources and determine the order in which 
they are displayed in the Sources window of the panel. For example, the router may have 64 
sources but you only want to make the first 12 inputs selectable on the soft panel. You would then 
move only the required sources from the Available list to the Assigned list.

To specify the sources for the soft panel

1. Double-click the panel name from the Panels list in the left toolbar of the Panels tab.

2. Click Sources.

3. To add a source to the soft panel:

a. From the Available list, select the source(s) you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected source(s).
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4. To assign all the available sources in the database to the soft panel, click .

5. To assign multiple sources to the soft panel:

a. From the Available list, select the first source you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other source(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected sources.

6. Use the provided buttons beside the Assigned list to determine the order in which the sources 
are displayed on the soft panel.

7. Click Apply at the bottom of the Panels tab to save your settings.

Adding Salvos to the Soft Panel
Before you can add salvos to a soft panel, you must configure them as outlined in the Ultrix User 
Guide. 

To specify the salvos available on the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Click Salvos.

3. To add a salvo to the soft panel:

a. From the Available list, select the salvo you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected source(s).

4. To assign all the available salvos in the database to the soft panel, click .

5. To assign multiple salvos to the soft panel:

a. From the Available list, select the first salvo you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other salvo(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected salvos.

6. Use the provided buttons beside the Assigned list to determine the order in which the salvos 
are displayed on the soft panel.

7. Click Apply at the bottom of the Panels tab to save your settings.

Adding a Favorite Button
The Favorites tab allows placement of common used items to aid in quick navigation on systems 
with many pages of sources and destinations.

The Favorites tab consists of a table of user defined favorites and buttons to aid their position and 
sorting. A Favorite may be deleted, edited, or deleted from the soft panel using the buttons on the 
tab.
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To add a Favorite button to the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Click Favorites.

3. Click Add.

The Add Favorites dialog opens.

4. Use the Name field to assign a unique identifier for the new favorite button.

5. Use the Style menu to specify the type of Favorites button to include. Choose from the 
following:

 You cannot assign multiple styles to a single Favorites button.

• Crosspoint — a source/destination combination where tapping this button executes a single 
switch request. Proceed to “To configure a Crosspoint button” to configure this button.

• Group — tapping this button accesses the group as defined by the Ultrix database group 
categories. Proceed to “To configure a Group button” to configure this button.

• Salvo — tapping this button executes the specified salvo. Proceed to “To configure a Salvo 
button” to configure this button.

• Source — tapping this button selects the specified source. Proceed to “To configure a 
Sources button” to configure this button.

• Destination — tapping this button selects the specified destination. Proceed to “To 
configure a Destination button” to configure this button.

To configure a Crosspoint button

1. Set the Style to Crosspoint.

The dialog updates to display a list of available destinations and sources in the current 
database.

2. Use the left column to specify the destination for the crosspoint switch.

3. Use the right column to specify the source for the crosspoint switch.

4. Click Apply.

The Add Favorites dialog closes.

The Favorites table updates to include the new button type.

To configure a Group button

1. Set the Style to Group.

The dialog updates to display a list of defined group categories in the current database.

2. Use the left column to navigate to the list of configured groups on the router.

3. Use the right column to select the group you want to access when the Favorite button is tapped 
on the panel.

4. Click Apply.

The Add Favorites dialog closes.

The Favorites table updates to include the new button type.

To configure a Salvo button

1. Set the Style to Salvo.

The dialog updates to display a list of configured salvos in the current database.

2. Select the salvo to execute when this Favorite button is tapped on the panel.
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3. Click Apply.

The Add Favorites dialog closes.

The Favorites table updates to include the new button type.

To configure a Sources button

1. Set the Style to Sources.

The dialog updates to display a list of available sources in the current database.

2. Select the source to access when this Favorite button is tapped on the panel.

3. Click Apply.

The Add Favorites dialog closes.

The Favorites table updates to include the new button type.

To configure a Destination button

1. Set the Style to Destinations.

The dialog updates to display a list of available destinations in the current database.

2. Select the destination to access when this Favorite button is tapped on the panel.

3. Click Apply.

The Add Favorites dialog closes.

The Favorites table updates to include the new button type.

To adjust the layout of the buttons on the soft panel

1. In the Favorites tab, select the row for the button to reposition.

2. Use the right toolbar to move the selection to its new location.

3. Click Apply to save your settings.

Defining the Home Page of the Soft Panel
When creating an Ultritouch soft panel, you also have the option to customize the different areas 
(windows) of the panel, and determine the width of each window, drawer, and their elements. A 
Home Page can be a collection of windows as defined during the soft panel configuration using the 
options in the Panels > Home View tab.

A soft panel is organized into distinct windows, each with a specific function. The number and type 
of windows your soft panel includes is determined during its configuration. Figure 20 shows a soft 
panel with three windows (from left to right): Destinations, Sources, and Operations.

Figure 20  Example of a Soft Panel with Three Windows

Table 1 summarizes the options for the types of windows you can assign to the Home Page.
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The options for defining the Home Windows elements of a soft panel are arranged in a table format 
of the Home View tab. You can chose to use the default settings, or customize the width and 
number of rows/columns in each window independently.

 The order of the rows in the Home Windows table determine the order of the windows that 
display on the soft panel. For example, if the first row is assigned to Sources, the first window 
next to the main toolbar of the soft panel will display the Sources buttons.

To define the Home Window elements of a soft panel

1. Navigate to the Panels interface.

2. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

3. Click Home View.

4. Locate the Home Windows table of the tab.

5. Select a row in the Home Windows table.

 Use the Up, Down, Top, Bottom, Sort buttons (located in the toolbar to the right of the table) to 
move a highlighted row to the desired position.

6. Click Add.

The Add Window dialog opens.

7. Use the Window menu to specify the first window to include in the soft panel.

 You cannot have multiples of the same window in either Home windows or Drawer windows.

8. Click Apply.

Table 1  Home Page — Types of Windows

Window Type Description
Category/Index Displays a Category-Index style of window on the soft panel.

Destinations Displays the destination selection buttons.

Favorites Adds a window of configurable sources, destinations, crosspoints, 
groups, and salvos. 

Filters Displays text filter to find source/destination. For example, the entered 
text  dest will find all source or destination labels that include dest* 
and Dest*.

Groups Displays a Group Categories style of window on the soft panel.

MV Heads Refer to “Multiviewer Operation”.

MV Layouts

MV Pips

Operations Adds a window that organizes the functions for router control (TAKE, 
Protect, etc) into buttons as defined using the Info tab.

Output monitor Adds a window that displays a a thumbnail of video.

Presets Displays the source/destination/level switch combinations that are 
cued for crosspoint control.

Salvos Adds a window that displays buttons representing the available salvos.

Sources Displays the defined source selection buttons.

Status Displays the level selection window and current multilevel status.
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The Add Window dialog closes and the Home Windows table updates to include the selection.

9. Repeat steps 5 to 8 for each window you want to include in the soft panel.

10. To customize a window of the soft panel:

a. Use the Percent (%) field to specify the percentage of the overall soft panel that the window 
will occupy. In the example above, the Destinations window is set to 50% while the Sources 
window is set to 30%.

b. Use the Rows field to specify the number of rows in the panel that the window will occupy.

c. Use the Columns field to specify the total number of columns in the panel that the window 
will occupy.

d. Select the Titlebar box to display a title bar across the top of the window. A title bar is only 
available on some window types.

11. Repeat step 10 for each window of the soft panel you wish to customize.

 The Total Width field above the Home Windows table reports the total alloted space in the soft 
panel. If the text is set in red, you must adjust the Percent (%) fields to ensure the total width 
meets 100% (but does not exceed). Otherwise the soft panel will not properly display on the 
Ultritouch.

12. Use the Display Icons menu to specify whether the buttons on the soft panel display the 
default icon images (Enable), or just the text labels (Disable). The default setting is Enable.

13. Click Apply.

The Information dialog opens.

14. Click OK to close the dialog and save your settings.

Defining the Drawers on a Soft Panel
Soft panels to control an Ultrix can also include fly-out menus (drawers) that operate like horizontal 
drop-down menus. You can specify what menus, functions, and settings each drawer includes.

Depending on how you configured your soft panel, some features may be only accessed by tapping 
a Drawer on the soft panel. A Drawer may also display as an overlay of other windows.

Figure 20 includes two drawers: one on the far left of the soft panel, and one on the far right. When 
a Drawer is tapped, the arrow on the drawer points in the opposite direction. Tapping a Drawer 
displays additional buttons available for selection (Figure 21), or windows. (Figure 22)

Figure 21  Example of a Drawer Displaying Additional Menu Options on the Left

Figure 22  Example of a Drawer Displaying Additional Menu Options on the Right
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To define the drawer elements of the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Click Home View.

3. Locate the Drawer Windows area of the tab.

 By default the Drawer window is populated with a right-side Status window and right-side Filters 
window, both occupying 50% of screen each. When multiple windows are assigned to either left 
or right drawers, the user must first select the drawer handle, then the window that is required.

4. Select a row in the Drawer Windows table.

 The order of the rows in the Drawer Windows table determine the order of the windows that 
display on the soft panel. For example, if the first row is assigned to Sources, the first window 
next to the main toolbar of the soft panel will display the Sources buttons.

5. Click Add.

The Add Drawer dialog opens.

6. Use the Type menu to specify the location of the drawer, in relation to the window it will be 
assigned to.

For example, if you select Type > Left and Window > Sources, the drawer will display on the 
left side of the Sources window.

7. Use the Window menu to specify the window to assign to the drawer to.

8. Click Apply.

The Add Window dialog closes and the Drawer Windows table updates to include the 
selection.

9. Repeat steps 5 to 8 for each drawer you want to include in the soft panel.

10. To customize a drawer size:

a. Use the Width field to specify the percentage of the allocated drawer space.

b. Use the Rows field to specify the number of rows in the drawer will display.

c. Use the Columns field to specify the total number of columns in the drawer will display.

 You can also use the Drawer Width menu, located near the top of the Home View tab, to specify 
the width of the drawer handle size.

11. Repeat step 10 for each drawer of the soft panel you wish to re-size.

In the example below, the Right drawer is assigned to the Status window, and the Left drawer is 
assigned to the Salvos window.

12. Click Apply.

The Information dialog opens.

13. Click OK to close the dialog and save your settings.

Loading a Soft Panel on Ultritouch
Loading a soft panel for a router via the Ultritouch menu system is similar to loading it from the 
Ultrix router tree in DashBoard. You first select the specific router and then navigate to the panel 
file defined in “Creating an Ultritouch Soft Panel”. Except on the soft panel, the navigation options 
are displayed as buttons (and not tree nodes).
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To load a soft panel on Ultritouch

1. Tap .

The All Connections interface displays.

2. Tap the router you want to control via Ultritouch.

In the following example, the Ultrix_140 router was selected. 

3. Tap the second button.

The panel updates to display the router hierarchy much like the tree view in the router menu 
system.

 Notice that the top toolbar reports where a breadcrumb trail reports your location in the menus. 
You can return to a previous menu by tapping < Back.

4. Tap Soft Panels.

A list of available soft panels displays.

5. Tap the required soft panel for the Ultritouch.

6. Tap Open.

The Ultritouch interface updates to display the selected soft panel.
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Switching with a Level, Destination, and Source
The Ultritouch soft panels are destination driven: you must first select a destination and then select 
the required source to be routed. 

To make a crosspoint switch

1. Load a soft panel to the Ultritouch as outlined in the procedure “To load a soft panel on 
Ultritouch”.

2. Tap the button for each level that you want to use.

 You may need to first tap a Drawer to display the Status window which includes the Level 
buttons.

3. Tap the Destination button to include in the switch.

4. Tap the Source button that you want to include in the switch.

5. If available, tap TAKE.

 If the Take mode was set to Automatic, crosspoint switches are performed automatically and 
the TAKE button does not display. Refer to “Adding Operation Features to the Soft Panel” for 
details on setting this mode.

6. If you want to protect the destination or prevent other users from changing the source 
selection, tap PROTECT.

Using Presets
A preset is a temporary list of crosspoint switches. Presets may be used to cue up a number of 
different crosspoint switches, then execute them all with one take command. Before proceeding, 
ensure that a Preset window is defined in the soft panel.

 The Take mode must be set to Confirm for presets to work. Refer to “Adding Operation 
Features to the Soft Panel” for details on setting this mode.

To use a preset

1. Load a soft panel to the Ultritouch as outlined in the procedure “To load a soft panel on 
Ultritouch”.

2. Tap the Destination button to include in the switch.

3. Tap the Source button that you want to include in the switch.

4. Tap PRESET.

 You may need to first tap a Drawer to display the Preset window.

5. Repeat steps 2 to 4 as needed.

6. Tap TAKE to execute all switches.

To view the preset list

• Tap VIEW.
The Preset list includes individual switches for every level that was including in the original 
selection.
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To clear the preset list

• Tap CLEAR.

Editing the Preset List
The Preset list all the individual levels of the switch requests currently in preset queue. Individual 
levels may be removed from the preset queue by selecting the switch request and tapping CLEAR in 
the Preset window.

To edit the preset list

1. Perform one of the following:

• Tap VIEW on the Operations window; or
• Expand the applicable drawer to display the PRESET > VIEW button.

2. Tap individual crosspoints.

3. Tap CLEAR on the Preset window.

Using Salvos
Salvos are a selected series of crosspoints to switch in the routing matrix that are saved and later 
recalled for use. A soft panel that includes a Salvos window provides access to the configured salvos 
in your routing system.

For More Information on...
• creating salvos in your database, refer to the Ultrix and Ultricore Database Guide.

Recalling a Salvo
Once you have created and saved your salvos, and created a soft panel with a Salvos window, you 
can recall each salvo from the Ultritouch. 

To recall a salvo from Ultritouch

1. Load a soft panel to the Ultritouch as outlined in “To load a soft panel on Ultritouch”.

2. Tap the button for the salvo you wish to recall.

Using Favorites
Before proceeding ensure that:

• one or more Favorite button is defined as outlined in “Adding a Favorite Button”.
• a Favorite window is accessible as defined on by the Home View configuration tab.

To use favorites

1. Load a soft panel to the Ultritouch as outlined in “To load a soft panel on Ultritouch”.

2. Tap the desired button from the Favorite window on the soft panel.

3. If the selected favorite is a source, crosspoint, or salvo, the soft panel TAKE configuration 
setting is honored;

• if the TAKE operation is set to confirm via soft panel configuration, the TAKE button (on 
operations window) must be tapped to send the switch request to the router.

• if the TAKE operations is set to direct, the switch request is sent immediately upon selecting 
the required favorite.
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Using the Output Monitor Window
 This feature requires that the Ultrix router run software 3v31 or higher.

For More Information on...
• creating and managing databases for your routing system, refer to the Ultrix and Ultricore 

Database Guide.

The Output Monitor window requires:

• you to be familiar with the Ultrix feature called Destination Follow for standard destinations 
(outputs).

• a third-party video Codec box downstream to the router. Contact Ross Technical Support for a list 
of supported boxes.

Figure 23  Example of Physical Connections for an Output Monitor Window

Configuration Requirements
Configuring the Output Monitor window for an Ultritouch PB soft panel requires the following 
steps:

1. Configure a destination on the Ultrix router to feed the third-party video Codec box. Refer to the 
Ultrix and Ultricore Database Guide for details on configuring destinations in a database.

2. Configure the third-party video Codec box to convert video to an IP thumbnail. Refer to the 
documentation that accompanied your box for details.

3. Decide whether the Output Monitor will be controlled via a standard destination-source 
selection, or via the Destination Follow mode.

• The Destination Follow mode allows a user to press any destination button, and the 
Ultritouch output monitor will update to show the current source on that destination.

• The Destination Follow selection requires that a destination name be entered on the 
Ultritouch soft panel Home View setting, and that the output monitor is defined as a viewable 
window on the Ultritouch soft panel. 

• The Destination Follow table in the Ultrix database does not need to be configured for this 
function. The destination follow table will automatically be populated when the user selects a 
destination button.
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4. On the Ultrix router, configure a new Ultritouch PB soft panel ensuring to:

• Use the OM Address field to specify the IP address or named resource of the third-party 
video Codec box.

• Use the OM Destination field to specify the Destination the Codec is connected to.

• Add an Output Monitor window to the soft panel (either on the Home Windows or as a 
Drawer feature).

5. Load the soft panel to the Ultritouch.

In the example below, the Output Monitor window displays on the far-right side of the soft 
panel.
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Multiviewer Operation
This chapter outlines how to design and use an Ultritouch MV soft panel type for Multiviewer 
control via the Ultritouch.

 This feature is not supported when the router is in a system that is controlled by an Ultricore BCS.

Before You Begin
Ensure the following are completed:

• At least one Ultriscape license key is installed for your router.
• At least one Ultriscape Head is enabled (via the Frame Configuration interface) on the router.
• Configure the Ultriscape Heads and PiPs in your router database.
• Assign each Ultriscape Head to a layout.

For More Information on...
• configuring and managing the Ultriscape Heads for a router, refer to the Ultriscape User Guide.

Soft Panel Overview
The Ultritouch MV Soft Panel enables you to control Multiviewer layouts, switch PiPs, and modify 
follow/non-follow modes directly from the Ultritouch panel. This section briefly summarizes the 
areas and windows on a typical Ultritouch MV Soft Panel.

Figure 24  Ultritouch MV Soft Panel — Layout Mode

Figure 25  Ultritouch MV Soft Panel — PiP Mode

1. Head Selection Area

When the panel is in Layout mode (LAYOUT is tapped), this area displays the available Ultriscape 
heads. Tap a head icon to select (Figure 24 shows slot 4 Head 1 as selected). Items that have a 
gray background are not selectable as they are not configured in the Ultrix database

2. Layout Selection Area

When the panel is in Layout mode (LAYOUT is tapped), this area displays the available layouts as 
configured in Ultrix. Tap a head icon to select from the head selections area, then select a layout 
to switch the head layout. The current selection is shown with a green outline. Figure 24 shows 
that the first available layout is selected.
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3. Control Area

This column of buttons enables you to select an element of an Ultriscape Head to display in the 
soft panel.

› LAYOUT — tap this button to display the MV Layouts options.
› PIP — tap this button to select display the MV PiPs options.
› APPLY — tap this button to apply any changes made to the Ultritouch MV soft panel.
› TAKE — tap this button to perform a crosspoint switch.

4. Sources Area

Each button in this area represents an input in the routing system. Tap a button to include assign 
the source to the currently selected PiP. 

5. Right Drawer

A navigation drawer is available on the right sides of the Ultriscape MV soft panel. Tap the drawer 
icon once to open a pane that provides access to the Destinations Follow window. Tap the drawer 
icon again to close the pane. 

6. Head Preview Area 

When the panel is in PiP mode (PIP is tapped), this area displays a preview of the selected layout.

7. PiP Selection Area

When the panel is in PiP control mode (PIP is tapped), this area displays the available PiP 
destinations. Tap a PiP destination button to select, then select a source from the sources area to 
switch the PiP source.

Creating a Soft Panel for Multiviewer Operation
Much like other types of soft panels, when you create a new Ultritouch MV soft panel, you select 
from an existing soft panel type (templates). You then assign a Panel Name and ID to display in the 
tree view using the nomenclature “Panel Name [#]” where [#] is the Panel ID.

To create a new soft panel for Ultritouch

1. Double-click the Panels node located under the Database node.

The Panels interface opens.

 The interface is blank when there are no configured soft panels.

2. Click Add.

The Add Panel dialog opens.

3. Click Edit... > Add.

The Add Panel dialog opens.
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4. Type a unique identifier in the Name field. 

This will be used to identify the panel in the Control > Panels tree.

5. If required, use the Description field to provide a textual summary of the panel.

6. Use the ID field to determine the position of the panel in the Control > Panels tree where a 
value of 1 is the highest priority and listed as the first node. 

 Ensure that the new soft panel does not use the same Panel ID as a previously saved soft panel.

7. Use the Style menu to select Ultritouch MV. 

This panel style enables you to control Multiviewer layouts, switch PiPs, and modify 
follow/non-follow modes directly from an Ultritouch hard panel. This option is not supported 
when the router is in a system that is controlled by an Ultricore.

8. Click Apply.

The Add Panel dialog closes.

The new panel name is added to the Saved Panels list of the Panels tab and automatically 
selected in the tab for editing.

To edit the Ultritouch MV soft panel operational features

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Refer to the Ultrix and Ultricore Database Guide to configure the required elements of the 
Ultritouch MV soft panel:

• Operation Features 
• Levels 
• Destinations
• Sources
• Salvos

Home View of an Ultritouch MV Soft Panel
By default, an Ultritouch MV Soft Panel is automatically configured to display the following:

• MV Heads — provides access to the Ultriscape Head Selection options of the connected router. 
Use this window to switch between the heads that are enabled on the router.

• MV Layouts — provides access to the Ultriscape Layout Editor of the connected router. Use this 
window to switch between layouts saved to the router database. 

• MV Pips — provides access to the defined Ultriscape PiPs of the connected router. Use this 
window to switch between configured PiPs.

• Sources — provides access to the available sources in the current database of the router.

 The Destination Follow drawer is not implemented.

For More Information on...
• customizing your soft panel, refer to the Ultrix and Ultricore Database Guide.

Using an Ultritouch MV Soft Panel
There are three basic functions of an Ultritouch MV Soft Panel: layout control, PiP selection, and 
enabling a PiP to follow a destination. This sections briefly outlines the elements of an Ultritouch 
MV Soft Panel and how to perform these basic functions.

 If communication is lost between the Ultritouch and the router, changes made during run-time 
on the Ultritouch MV Soft Panel are not retained. 
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Layout Control
Each Ultriscape Head in your system can use the same layout, or different layouts depending on 
your needs. Both instances share the same layout properties, but can have different sources 
assigned to each PiP. The list of available sources to assign to each PiP depends on the currently 
loaded database for the Ultritouch router.

To change the layout loaded to a specific Ultriscape Head

1. Load the soft panel as outlined in “Loading a Soft Panel on Ultritouch”.

2. In the MV Heads window, tap the Ultriscape Head you want to control.

3. In the Control window, tap LAYOUT.

 Inactive Ultriscape Heads are grayed out and may not be selected for control.

4. In the MV Layouts window, tap the layout from the MV Layouts window.

The selected layout displays with a green border around its thumbnail.

5. Tap Apply to confirm your selections and change the layout from the selected Ultriscape Head.

PiP Selection
A PiP source is controlled by routing just like any destination. Each PiP in a layout is assigned a video 
signal from the Head Selection interface. If the input signal includes embedded audio, the audio is 
included in the Ultriscape Head output.

To change the source for a PiP

1. Load the soft panel as outlined in “Loading a Soft Panel on Ultritouch”.

2. Select a layout as outlined in “To change the layout loaded to a specific Ultriscape Head”. 

3. In the Control window, tap PIP.

4. In the MV Pips window, tap the PiP you want to control.

5. In the Sources window, tap the source that you want to use for the selected PiP.

6. Tap Apply to confirm your selections and change the PiP Source.
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Using Categories
This chapter outlines how to use an Ultritouch soft panel that includes Category Index and Group 
Category elements to perform crosspoint switches on an Ultrix router.

Using Category/Index Mode
Category/Index mode allows alpha-numeric extensions to labels to “build up” the final label 
selection. Destination and source names are split into substrings - the first substring is referred to 
as the category and the subsequent substrings as the indexes. Once the Cat/Index categories are 
defined, the user can perform switches on the Ultritouch based on these categories. 

Before You Begin
Before you can load a soft panel with Category Index elements, you must first:

1. Assign categories within the database.

2. Assign indexes within the database.

3. Configure an Ultritouch soft panel to include a Category Index window.

For More Information on...
• on assigning categories and indexes, refer to the Ultrix and Ultricore Database Guide.

Soft Panel Overview
Figure 26 provides an example of an Ultritouch soft panel with a Category Index window and 
buttons.

Figure 26  Example of a Default Category/Index Soft Panel Layout

1. Category Index Window

This window provides access to the Destination and Source buttons for selected categories and 
indexes defined in the Ultrix database. The buttons that display in this window change depending 
on whether the DEST or SRC button was tapped. In Figure 26, the user tapped SRC, and the 
Category Index window displays buttons assigned to the Source category.

A Category Index window is added to an Ultritouch PB soft panel during configuration as outlined 
in “Defining the Home Page of the Soft Panel”.

2. Status

This area reports the current selection (Dest and Src).

3. Button Paging

Tap these buttons to scroll up/down the window.
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4. Operations Window

The Operations window includes the following buttons for Category/Index mode:

› DEST — Tap this button to display the Destination category buttons in the Category Index 
window.

› SRC — Tap this button to display the Source category buttons in the Category Index window.
› BACK, CLEAR — Use these buttons to back up one step and clear current selections 

respectively.
› SELECT — Tap this button to confirm your crosspoint choices. This button is only available 

when the SRC and DEST selections are valid.

Creating a Soft Panel for Category/Index Mode
Creating a soft panel for operating an Ultrix router in Category/Index mode requires the same basic 
steps as other soft panels except you set the Window type to 

To create a new Ultritouch soft panel with a Category/Index window

1. Ensure that you assigned the required categories and indexes within the Ultrix database.

2. Create a soft panel as outlined in the procedure “To create a new soft panel for Ultritouch”.

3. In the Panels interface for the new soft panel, click Home View.

4. Locate the Home Windows table in the Home View tab.

5. Click Add.

The Add Window dialog opens.

6. Use the Window menu to select Category/Index.

7. Click Apply.

The Add Window dialog closes and a new row displays in the Home Windows table.

8. Use the Up, Down, Top, and/or Bottom buttons to position the Category/Index row within the 
table. This will determine where the window is located on the finished soft panel.

9. Use the Percent (%) field to specify the percentage of the overall soft panel that the 
Category/Index window will occupy. 

10. Use the Rows field to specify the number of rows in the panel that the Category/Index window 
will occupy.

11. Use the Columns field to specify the total number of columns in the panel that the 
Category/Index window will occupy.

12. Click Apply.

The Information dialog opens.

13. Click OK to close the dialog and save your settings.

To create a new Ultritouch soft panel with a Category/Index window in a drawer

1. Create a soft panel as outlined in the procedure “To create a new soft panel for Ultritouch”.

2. Edit the soft panel as outlined in the procedure “To edit the soft panel operational features”.

3. Click Home View.

4. Locate the Drawer Windows table in the Home View tab.

5. Click Add.

The Add Drawer Window dialog opens.
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6. Use the Type menu to specify whether the Category/Index window will be displayed on the Left 
Drawer or Right Drawer.

7. Use the Window menu to select Category/Index.

8. Click Apply.

The Add Window dialog closes and a new row displays in the Drawer Windows table.

9. Use the Up, Down, Top, and/or Bottom buttons to position the Category/Index row within the 
table. This will determine where the window is located on the drawer.

10. Use the Percent (%) field to specify the percentage of the overall drawer that the 
Category/Index window will occupy. 

11. Use the Rows field to specify the number of rows in the drawer that the Category/Index window 
will occupy.

12. Use the Columns field to specify the total number of columns in the drawer that the 
Category/Index window will occupy.

13. Click Apply.

The Information dialog opens.

14. Click OK to close the dialog and save your settings.

Using Category/Index Mode
 The categories and indexes must be defined in the Ultrix router database before Ultritouch can 

control the router using Category/Index mode.

To make a crosspoint change

1. Load a soft panel, configured for Category/Index mode, to the Ultritouch as outlined in the 
procedure “To load a soft panel on Ultritouch”.

2. To select a destination:

a. Tap DEST.

b. Tap a Destination category.

3. Tap a Destination Index.

4. Tap SELECT to confirm your destination choice.

 The SELECT button is only enabled when the selections made in steps b and 3 are valid.

The panel enters Source Selection mode.
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5. Select the Source Category.

6. Select the Source Index.

• TAKE becomes available when the navigation results in a valid source selection.
• PRESET may also be used to add multiple switches to a PRESET cue. The PRESET cue can be 

then executed with a single TAKE command.

7. Tap TAKE to send the switch request to the router.

Using Group Categories
Group categories allow arbitrary grouping of source and destination names. These groupings are 
fully customizable to suit your particular workflow. 

Before You Begin
Before you can load a soft panel with Group element, you must first:

1. Define the group categories within the database. Refer to the Ultrix and Ultricore Database 
Guide.

2. Configure an Ultritouch soft panel to include a Group window. Refer to the Ultrix and Ultricore 
Database Guide.

Soft Panel Overview
Figure 27 provides an example of an Ultritouch soft panel with two group categories defined as 
EDIT 1 and EDIT 2. Both contain various source and destination names. EDIT 1 also contains a 
sub-group.
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Figure 27  Example of a Default Soft Panel Layout with a Group Window

1. Title Bar

If enabled, a title bar will be displayed top most of the screen. The current group navigation will 
be displayed as a breadcrumb style upon entering any group.

2. DEST Mode Button

Select this button to show only destinations from any group.

3. SRC Mode Button

Select this button to show only sources in any group.

4. LEV Mode Button

Select this button to show only levels in any group.

5. TOP Button

Select this to navigate to the top most group.

6. BACK Button

Select this to navigate back on step in the group hierarchy.

7. Central Area

The central/main area of the screen displays the groups and any configured source, destination, 
and level buttons. The Groups are identified by the folder icon.

 A group category is only visible if it contains defined contents for the current mode selected. For 
example, if the current select mode is DEST, and group EDIT 2 contains no destinations, then the 
EDIT 2 group will not be navigable in DEST mode.

Using Group Categories on a Soft Panel
This section outlines how to perform a simple crosspoint switch via a soft panel using Group 
categories. There are three steps you must perform before sending the switch request to the 
router:

1. Select the required level(s) using one of the following methods:

• using the group category defined levels, or 
• using the status window

2. Select the required destination.

3. Select the required source.

To select the required levels for the operation

• Using the group category defined levels:

a. Tap LEV.

b. Tap the required level(s). 

A selected level will highlight blue. To de-select, tap again.

• Using the status window:
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a. Open the status window (if needed)

b. Tap the required level(s).

Omitting a level selection will mean the switch request will use the current level selection from a 
previous operation.

To select the required destination

1. Tap DEST.

2. Navigate to the group.

3. Tap the required destination.

To select the required source

1. Tap SRC.

2. Navigate to the group.

3. Tap the required source.

To perform the switch

• If the TAKE operation is set to Confirm via soft panel configuration, the TAKE button (on the 
Operations window) must be tapped to send the switch request to the router, or

• If the TAKE operations is set to Direct, the switch request is sent immediately upon selecting the 
required source.
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Communications with Devices
This chapter provides a general procedure for creating a connection point between the Ultritouch 
and external devices in your routing system. The specific steps for your devices may differ than 
what is presented here. 

 The procedures in this chapter assume you are navigating the Ultritouch menus via the hard 
panel. 

For More Information on...
• the menu system, refer to “Menu System Overview”.
• creating a connection point between the Ultritouch and your device, refer to the Ultrix and 

Ultricore Database Guide.

Before You Begin
The Connected Devices interface lists external devices that the Ultritouch detects and can connect 
to, and provides status information. You can also disconnect communications between a device 
from Ultritouch. There are two methods for adding an external device to the Ultritouch: using the 
auto connect feature or manually adding a device by specifying the IP address of the device. Both 
methods are described in this chapter.

 You can also drag and drop devices nodes from the Basic Tree View to the Ultritouch Connected 
Devices tab in a DashBoard client. Refer to the Ultritouch Quick Start Guide for details.

 This chapter uses the Ultritouch-2-HR in its examples, but the information also applies to the 
Ultritouch-4.

Automating Connections
There are two features that you can use to auto detect and connect to external devices in your 
routing system.

Using the Auto Detect Feature
By default the Ultritouch auto detects any external device on the same IP subnet. Ultritouch queries 
the network for new devices approximately every 10 seconds if the Automatic Detection feature is 
enabled.

To enable the Ultritouch to auto detect external devices in your routing system

1. Tap .

2. Tap Connected Devices.

3. Tap Enable Auto Detect.

Using the Auto Connect Feature
The auto connect feature is independent from the auto detect feature. This allows you to still 
manually select what devices to connect to. Once the auto connect feature is enabled, Ultritouch 
will automatically create a connection point to devices listed in the Connected Devices table.

To enable the Ultritouch to auto connect to external devices in your routing system

1. Tap .

2. Tap Connected Devices.
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3. Tap Enable Auto Connect.

Manually Connecting to an External Device
You must manually create a connection point to an external device when the device is on a different 
subnet from your Ultritouch. 

If the Auto Detect or Auto Connect options are disabled, you can still create a connection point to an 
external device by manually specifying their IP address in the Ultritouch Device interface.

To manually add a connection point to an external device

1. Tap .

2. Tap Connected Devices.

3. Tap Add.

4. Tap Manually Add a Connection Point.

5. Use the Device IP/Hostname field to specify the IP Address for the external device.

6. Tap Add Device.

The device is now listed in the Connected Devices table.

7. Select the device from the Connected Devices table.

8. Tap Connect.

OGP and JSON Connections
This section outlines how to establish a connection point when your device communicates over TCP 
via the openGear protocol (OGP) or the JavaScript Object Notation (JSON).

To manually add a connection point to an external device via OGP or JSON protocol

1. Tap .

2. Tap Connected Devices.

3. Tap Add.

4. Tap TCP/IP DashBoard Connect/openGear Device.

5. Use the Device IP/Hostname field to specify the IP Address for the external device.

6. Use the Device Name field to specify the device name (as you want it to appear in the 
Ultritouch interfaces).

7. Use the Protocol menu to specify whether the device communication language. 

8. Use the Port field to specify the port on the device used for communicating with the Ultritouch.

9. Select the Remember connection settings for this device to retain the settings after a loss of 
communication.

10. Tap Add Device. 

11. Select the device from the Connected Devices table.

12. Tap Connect.
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File Management
This chapter outlines how to use the File Navigator interface to load your custom panel and device 
files to the Ultritouch. 

 This chapter uses the Ultritouch-2-HR in its examples, but the information also applies to the 
Ultritouch-4.

 A connection must be established between Ultritouch and the device that you are uploading the 
file to. Refer to “Communications with Devices” for details.

Loading Custom Panels
The File Navigator interface enables you to quickly navigate to device custom panels. A custom 
panel is a user interface created using the PanelBuilder™ tool in DashBoard. Custom panels can 
include any combination of PanelBuilder objects, panel components, and parameters. Custom 
panels enable you to create interfaces for your DashBoard Connect devices, then load the panel file 
to the Ultritouch for operating and monitoring that device.

For More Information on...
• using PanelBuilder, refer to the DashBoard User Guide.

Before You Begin
PanelBuilder provides a template for creating and editing a custom panel for use on an Ultritouch 
hard panel. This template is a canvas layout of 1304x203 pixels to match the hard panel display 
area. You must create a custom panel using PanelBuilder on your DashBoard client computer 
before you can upload and use it on Ultritouch.

Figure 28  Ultritouch — Example of a Loaded Custom Panel

For More Information on...
• creating and editing custom panels for Ultritouch, refer to the DashBoard User Guide.
• creating a soft panel for Ultrix, refer to the Ultrix and Ultricore Database Guide.

Uploading a Custom Panel File to the Ultritouch Directory
Once you have created your Ultritouch custom panel in PanelBuilder, you can open and load the file 
to an Ultritouch hard panel. You can upload multiple custom panels to the Ultritouch system, but 
the hard panel can only display one custom panel at a time.

 Before proceeding, ensure you have established communications between the Ultritouch and the 
device the custom panel was designed for.

To upload a custom panel file to the Ultritouch
1. Navigate to the Ultritouch Device interface using the method described in “To access the 

Ultritouch Device interface via a DashBoard client computer”.

2. Click Manage Custom Panels.

The Custom Panels interface displays in the DashBoard window.
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3. Click Upload to Folder.

The Upload File dialog opens.

4. Select the custom panel file to load.

 Uploaded *.zip files (custom panels with image assets etc.) are automatically unzipped into a 
directory named the same as the original *.zip file.

Using Custom Panels
To operate a custom Panel, use the File Navigator to browse the Custom Panels directory. The File 
Navigator interface displays and uploaded custom panels in a hierarchy. This hierarchy is 
determined by the timestamp of the loaded files.

To open a custom panel

1. On the Ultritouch hard panel, tap .

2. Navigate to the file you wish to open.

3. Tap Open File.

To remove a device file from the File Navigator interface

1. On the Ultritouch hard panel, tap .

2. Navigate to the file you wish to remove.

3. Tap the file to reveal the available operations.

4. Tap Remove.
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Managing Open Windows
Ultritouch tracks the DashBoard Connect devices that you frequently access and arranges their 
“view” in a single window for ease of use.

 This chapter uses the Ultritouch-2-HR in its examples, but the information also applies to the 
Ultritouch-4.

To specify a new device view

1. Tap .

2. Tap Manage Open Views.

3. Perform one of the following:

•  — Tap this button to display the Devices Navigation interface.

•  — Tap this button to display the Files Navigation interface.

The interface updates to show a list of external devices made available using the procedures in 
“Communications with Devices”.

4. Tap the device you wish to view.

5. Tap Open Selected.

To specify a new file view

1. Tap .

2. Tap Manage Open Views.

3. Tap Files.

The interface updates to show a list of devices files made available using the procedures in 
“Using File Navigator”.

4. Tap the entry for the file you wish to view.

5. Tap Open Selected.

To view a new device interface on the Ultritouch
1. Tap .

2. Tap the entry for the device you wish to access.
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To close a device interface from the Ultritouch
1. Tap .

2. Tap the X next to the device name you wish to close.
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Menu System Overview
There are two methods for accessing the interfaces: a DashBoard client computer or using the 
Ultritouch hard panel. This chapter outlines the menus available using both methods but uses the 
menus from the hard panel in the provided examples.

 This chapter uses the Ultritouch-2-HR in most of the examples, but the information also applies 
to the Ultritouch-4 unless otherwise noted.

Ultritouch Device Interface
Use this interface to change the network settings for the panel, establish communications with 
devices in your routing system, manage your custom panels, and download system logs for 
troubleshooting.

General Info
By default, the General Info window is automatically displayed when the Ultritouch Device interface 
is loaded.

 To access this interface on a DashBoard client computer, double-click the Ultritouch Device 
sub-node in the Tree View.

Figure 29  Example of the General Info Window on an Ultritouch-2-HR Panel

Table 2 summarizes the read-only fields displayed in the General Info window. 
Table 2  General Info

Item Parameters Description
Device Name <text> Identifier assigned to this panel during the 

installation and setup

Device ID # An unique number assigned to the hard 
panel to help identify it within your system

Type <text> Defines the model of Ultritouch panel

Serial # Indicates the serial number of the 
Ultritouch panel

DashBoard Version # Indicates the DashBoard client version 
running on the Ultritouch panel

Firmware Version # Indicates the build version of the Ultritouch 
panel
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Manage Open Views
The Open Views interface display a list of custom panels and/or device files that were previously 
loaded to the Ultritouch panel. To access this interface, tap Manage Open Views. 

Figure 30  Example of the Manage Open Views Window

Table 3 summarizes the fields displayed in the Manage Open Views window.

Manage Custom Panels
Use the Manage Custom Panels interface to load a custom panel file to the Ultritouch panel.

 You cannot edit a custom panel using this interface. Use the PanelBuilder™ feature in a 
DashBoard client to create and edit custom panels for the Ultritouch. Refer to the DashBoard 
User Guide for details.

Figure 31  Example of the Manage Custom Panels Window

Connected Devices
The Connected Devices interface provides information on the external devices currently 
communicating with the Ultritouch panel. From this interface you can manage which devices the 
Ultritouch can access. 

Download Logs *.txt Enables you to capture the communication 
activity of the panel into a text file

Upload Enables you to update the DashBoard 
software running on your Ultritouch

Table 3  Manage Open Views

Item Description
Devices Tap this button to display a hierarchical list of 

external devices that have established 
communications with this Ultritouch

Files Tap this icon to display a list of files recently 
accessed by Ultritouch

Show Navigation Tap this button to display the navigation tree for

Open Selected Tap this button to load the interface for the selected 
device

Table 2  General Info

Item Parameters Description
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Figure 32  Example of the Connected Devices Window

Table 4 summarizes the fields displayed in the Connected Devices window.

Network Settings
The Network Settings window enables you to edit and verify the IP Address and other settings 
according to your facility network requirements.

Figure 33  Example of the Network Settings Window

Table 5 summarizes the fields displayed in the Network Settings window.

Table 4  Connected Devices

Item Description
Device Name Reports the name assigned to the external device

Status Duplicates the status reported by the device. Refer to 
the user guide for the device to learn more about the 
possible messages.

Add Use this button to manually add a new device to the list 
of Connected Devices

Remove Use this button to manually remove a device from the 
list of Connected Devices

Enable Auto Detect Enables Ultritouch to auto-detect any DashBoard 
Connect compatible devices on the same IP subnet and 
add the device to the Connected Devices table

Enable Auto 
Connect

Enables Ultritouch to automatically connect to 
DashBoard Connect compatible devices and add them 
to the Connected Devices table

Connect Enables communication between the selected device 
and Ultritouch

Disconnect Disables communication between the selected device 
and Ultritouch
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Device Options
The Device Options window enables you to adjust the display brightness and speaker volume, 
calibrate the hard panel settings back to their default settings, and initiate a reboot of the panel.

All Connections
The All Connections interface provides access to the menu system and operational features of 
DashBoard Connect compatible devices. Only devices added via the Connected Devices interface, 
with established connections to Ultritouch, are accessible in this interface.

Tap  on the hard panel to display the All Connections interface. (Figure 34) 

Figure 34  Example of the All Connections Interface

For More Information on...
• the menu system for your DashBoard Connect compatible device, refer to its user guide.

File Navigator Interface
The File Navigator interface in Ultritouch enables you to quickly navigate to any installed Custom 
Panel file. Custom Panels are created using the PanelBuilder tool in the DashBoard client software.

Tap  on the hard panel to display the File Navigator interface. (Figure 35)

Table 5  Network Settings

Item Parameters Description
IP ###.###.###.### Specifies the IP address for the Ultritouch 

panel

Mask ###.###.###.### Specifies the subnet mask for the Ultritouch 
panel

Gateway ###.###.###.### Specifies the gateway for communication 
outside of the local area network (LAN)

DNS (Primary) ###.###.###.### Specifies the Primary Domain Name Server 
for your network

DNS (Secondary) ###.###.###.### Specifies the Secondary Domain Name 
Server for your network

DHCP Off The user manually supplies the network 
settings for the Ultritouch panel

On Automates the assignment of network 
settings for the Ultritouch panel
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Figure 35  Example of the File Navigator Interface

Open Windows Interface
The Open Windows interface in Ultritouch reports which device interfaces were recently accessed 
by the Ultritouch. Each device is represented by a pane in the interface which includes a thumbnail 
of the last menu/tab that was accessed and a status bar. Select a pane to display that device on the 
Ultritouch, or scroll through the panes to quickly monitor the devices communicating with 
Ultritouch.

Tap  on the hard panel to display the Open Windows interface. (Figure 36)

Figure 36  Example of the Open Windows Interface

Lock the Ultritouch Interface
You can choose to lock the hard panel so that all menus and parameters cannot be accessed.

Tap  on the hard panel to lock the panel. (Figure 37)

Figure 37  Example of a Locked Panel
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Technical Specifications
This chapter provides technical information for Ultritouch. Note that specifications are subject to 
change without notice.

Physical Dimensions

Ethernet Port Connectors
Each Ultritouch comes standard with two Ethernet ports on the rear panel to interface with a local 
network, and Ross devices that use an Ethernet protocol for communications. The Ethernet ports 
are operated in a link aggregated or bonded configuration to provide failover functionality.

 The ENET 2 port is not implemented.

Environmental

Table 6  Technical Specifications — Physical Dimensions

Item Specification
Ultritouch-2-HR

Width 19” (48cm)

Depth 2.5” (6cm)

Height 3.5” (9cm)

Weight (approx.) 5.25lb (2.40kg)

Ultritouch-4

Width 19” (48cm)

Depth 2.6” (6.5cm)

Height 7.0” (18cm)

Weight (approx.) 12.0lb (5.40kg)

Table 7  Technical Specifications — Ethernet Ports

Item Specifications
Number of Ports 1

Connector Type 8-pin, RJ45 

Table 8  Technical Specifications — Environmental

Item Specifications
Maximum Ambient 
Temperature Range

0°C to 40°C (32°F to 104°F)

Humidity, non-condensing < 95%
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Power
Table 9  Technical Specifications — Power Supply Ratings

Item Specifications
Ultritouch-2-HR

Number of Ports 2

Power 15VDC @ 4A

Input 100-240Vac, 50/60Hz

Input Current 1.4A

Ultritouch-4

Number of Ports 2

Power 15VDC @ 4A

Input 100-240Vac, 50/60Hz

Input Current 1.4A
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Glossary
The following terms are used throughout this guide:

Breakaway — an act of performing a switch on only some of the signals grouped together under 
one label.

Connection Point — setting to define a communication connection between Ultritouch and a 
device in the routing system.

Crosspoint — a switch within a matrix. For example, the connection of signal IN 1 to OUT 1 requires 
one crosspoint.

Destination — a signal output from the routing system.

Hard Panel — the physical Ultritouch panel that provides a touchscreen interface to the menu 
system.

IP Address — a setting that defines the Internet protocol address of a device within a network.

Label — text that is used by control displays to identify a signal as an input or output.

Level — refers to a section of a routing system. For example, a video router would be one level and 
an audio router would be a second level.

Logical (virtual) Label — a name for a group of routing system inputs or outputs.

Logical (virtual) Routing — the action of switching a group of otherwise unrelated signals via a 
common label (name).

Remote Control Panel (RCP) — a physical hardware panel of buttons that is used to control the 
routing system.

Salvo — a system wide sequence of matrix control operations and crosspoint actions.

Soft Panel — a DashBoard software interface that represents a panel of buttons that is used to 
control the routing system.

Source — a signal input to the routing system.

Ultritouch — refers to the Ultritouch-2-HR and Ultritouch-4 unless otherwise noted.

Ultritouch-2 — refers to an Ultritouch 2RU with a resolution of 1440 x 230.

Ultritouch-2-HR — refers to an Ultritouch 2RU with a resolution of 1920 x 285.

Virtual Label — a name for a group of routing system inputs or outputs.

Virtual Routing — the action of switching a group of otherwise unrelated signals via a common 
label (name).
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